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Introduction

Humans are great at processing images, but
we are NOT good at processing datasets.
Data Tables called Spreadsheets were
invented to organize arrays of information.
Spreadsheets help us sort and label in an
organized way.

We can reference it and perform calculations later.



Papyrus Spreadsheets

The practice actually dates back thousand of
years (Egyptian Old Kingdom)
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From Paper to Online Sheets

VisiCalc was the first digital spreadsheet
As our tools evolved, programs like Excel

made digital spreadsheets one of the most
popular uses of computers
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Spreadsheets were tied to a single machine
Difficult to share data

If your sheet was accidently erased or lost due

to computer failure, it was gone.

Google brought spreadsheets online

You can create spreadsheets together with other
online

Crunch numbers from any internet-connected
device
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App on Steroids

It is web-based

can be used anywhere
It works from any device

even with mobile apps for iOS and Android
It is free

bundled with Google Drive, Docs and Slides to
share filed, documents and presentations online

If you know how to use Excel you will feel at
home in Google Sheets
You can download add-ons,

Also create your own, and write custom code
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Create a Spreadsheet and Fill it with Data

Click “NEW” on Google Drive dashboard and select Google Sheets
File > New Spreadsheet
Click “Blank”

or select a template on the Google Sheets homepage

GO g|e Spreadsheet Basics Tutorial & Google KB

File Edit View Insert Format Data Tools Add-ons Help L

& Drive My Drive Share... [ o | a0 - = Sheets
/ New > Start a new spreadsheet

B Document

[ | m o m o Spreadsheet
§ Rename... .
, B3 Folder 2 Presentation
3 Make a copy... E Form
4 z 7
File upload : I Move to folder... B Drawing To-do list 2015 Calendar Invoice
B3 Folder upload 6 W Movetotrash From template...
7 Import...
8
Google Docs . .
= 09 ER02 9 See revision history 38 +Option+Shift+G
Google Sheets 10 Spreadsheet settings...
1
Google Slides = Download as <
More > 13 Publish to the web...

Email collaborators...

16 Email as attachment...

B Tp 5 = Print #P

1 2 3
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Familiar Text Editing Icons

= Spreadsheet Basics Tutorial michael@michaelgrubbs.com ~
File Edit View Insert Format Data Tools Add-ons Help  All changes saved in Drive Comments
= a P8 % o0 201 Arial 10 B 7 5 A @ - B =1 |- cocHMYT - -Z

: Default Google Sheets Interface

Sheet1

+
[l
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Adding Data to Your Spreadsheet

Copy and Paste

Spreadsheet Basics Tutorial miehael@michacigruobs.com
File Edit View Insert Format Data Tools Add-ons Help Al changes saved in Drive COnEnROE | Movies, TV Celebs, Events e
& Showtimes & Photos M
& e o~ T 5 % .0 .00 123- Ardal 10 BE 7 5 A. & H More
IMDb Charts
A B c [») E F G

: Top Rated Movies

Top 250 as voted by [MDb Users

%)

Copy & Paste of data that looks like a table usually works

Showing 250 Titles Sort by: | Ranking | 4

IMDb Your
Rank & Title Rating Rating

@ u mowm bow

-

. The Shawshank Redemption {1994) 9.2

M

. The Godfather (1972) 9.2

w

. The Godfather: Part II (1974) 9.0

IS

. The Dark Knight (2008) 8.9

w

. 12 Angry Men (1957) 8.9

o

. Schindler's List {1993) 8.9

~

. Pulp Fiction (1994) 8.9

u
B
7
5
o

. The Good, the Bad and the Ugly {1966) 8.9

9. The Lord of the Rings: The Return of the King

(2003) ES

+ = Sheetl

I nmir Pra X0
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Import File

Most common files to import are CSV or XLS

FILE > IMPORT > UPLOAD

Spreadsheet Basics Tutorial
File Edit View Insert Format Data Tools Add-ons Help

All changes saved in Drive

® - B

Arial 10

[l
[+~

&~ s % g 00123 B 7 5 A

A B c o] E F

I

3 You can also create new sheets with the "+" down here
2\

+ = Sheet1

Untitled spreadsheet -...csv * & Copy-and-paste-data-i....gif ~

menu

michael@michaelgrubbs.com

Comments |

Importing an existing spreadsheet file into a new Google "Sheet" is easy

4§ Show All
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Dragging to copy a cell value

Dragging to copy is very useful and handy

—a Drag this to copy a cell to
others quickly
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Clicking and Dragging

Spreadsheet Basics Tutorial

File Edit View Insert Format Data Tools Add-ons Help  All changes saved in Drive

= e AT s % .0 .00 123-  Aral 10 B 7 5= A. %-H
- - —

I
|~
T
s
m
El
<
M

A B c D = 7 G H

[ 1]

-

ES TN - T = S I - T~

=
E 4

L T T S e v e Sy
en b e R = @ R @~ R & B W R
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Format Data for Easy Viewing

Whenever you are tracking expenses, keeping
customers in a CRM, you will want to
manipulate and format your data

Copy Cell Advanced
Print Formatting Font Settings Cell Outlines (Explained Later)
1 L | 1
& e o~ T 0§ % .0 .00 123-  Aral 10 B 7 5 A. ®-H =l o os Bl 5
T | | |
Undo / Redo Format Font Styling Cell Data

Number as... Alignment
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Potential Breakfast Options

= Spreadsheet Basics Tutorial
File Edit View Insert Formmat Data Tools Add-ons Help  All changes saved in Drive

& o ~ P 0§ % 0 00123 Aral 10 B 7 5 A. ®.H E-1l-|+- cocBHMmMY-Z
A B = D E F G
1
Ingredient List Scrambled Eggs French Toast Cereal Muffin Doughnut

2  Eggs 4 2 1 1
3 Bread 2
4 Milke 2
5  Cereal (or Flour) 2 3
&  Butter 1 1 2 2
7 Salt 1
8  Sugar 2 3 4
8  Total "Parts" Needed g 7
10 Number of Ingredients 3 4 2 4 4
11 Avg Price / Serving 0.8 0.99 0.75 1 1.25
12 Tutorial Link https:/iwww.youtube comiwal hitps:\www.youtube.com/wa https:/iwww.youtube.com/v hitps:/www.youtube.con hitps:/iwww.youtube.com/watch Pv=itdza8kY0zY
13
14 . . . .
s You can easily create something like this... But let's
16 _ )
v clean it up and make it awesome!
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“Freeze” the First Row

That means if we scroll down the
spreadsheet, the first for will still be visible.

= Spreadsh asics Tutorial
File Edit WView Insert Format Data Add-ons Help  All changes saved in Drive
¥ o A  Freeze > No rows s A. % H =-1l-|+- coEHMY-X
4 " Gridlines 1 row
A D E F G

Protected ranges 2 rows

Up to current row (10)
gredient Lis ' FEormula bar zreal Muffin Doughnut

=

2 I No columns 1 o1
Allf I Cirl 1" 1"
. ormutee il I Select to "Freeze" the first
4 2
5 al (or Flc 2 colusmns row : 3
6 Compact controls Ctrl+Shift+F Up to current column (E) 2 2
! Full screen
] 2 3 4
] rts” Needed 6 T
10 NumberWf Ingredients 3 4 2 4| 4
1 Serving 0.8 0.99 0.75 1 1.25
12 https:ifwww.youtube .comiwal https:iwww.youtube.comiwa hitps:/Awww.youtube.comf https:/iwww.youtube cormr hitps:/f'www.youtube.comfwatch Pv=itdzaBkY 0z
13
14 . .
s Or grab this dark grey bar and drag it between row 1 and 2
16
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Text Formatting

Spreadsheet Basics Tutorial

File Edit View Insert Format Data Tools Add-ons Help  All changes saved in Drive

& e~ P 0§ % .0 00125~ Aal 10 B 7 5 A. % M =E-1-|%- coBMY - Z
2
A B G D E F G

1

Ingredient List Scrambled Eggs French Toast Cereal Muffin Doughnut
2 Eggs 4 2 1 1
3 Bread 2
4 Milk 2
5  Cereal (or Flour) 2
6 Butter 1 1 2 2|
7 Salt 1
8  Sugar 2 3 4
%  Total "Parts” Needed B 7
10 | Number of Ingredients 3 4 2 4 4
11 | Avg Price [/ Serving 0.8 0.99 0.75 1 1.25
12 | Tutorial Link hitps/hwww.youtube.com/wal hitps:/iwww.youtube.comiwa hitps:/fwww.youtube.comiv hitps://www.youtube.con https://www.youtube.comiwatch?v=itdza8kY 0z
13
14
. %
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Currency Formatting

2
3
4
5
&
7
8
9

Wwoh = o

Spreadsheet Basics Tutorial

File Edit View Insert Format Data Tools Add-ons Help All changes saved in Drive

5o P % .0_ .00 123+ Arial 10 B 7 5 A. - MH-B: =E-1-|+- cocBMY-Z
Avg Price / Serving
A B D E F €]
Scrambled Eggs French Toast Cereal Muffin Doughnut

Ingredient List

Eggs 4 2 1 1

Bread 2

Milk 2

Cereal (or Flour) 2

Butter 1 1 2

Salt 1

Sugar 2 3 4

Total "Parts" Needed 6 7 B efo re

Number of Ingredients 3 4 2 4 4

|Avg Price / Serving | 0.8 0.99 0.75 1 1.25 |

Tutorial Link https:/fwww.youtube.comfwali hitps://www.youtube.comiwa hitps:/'www.youtube.com/w https:/www.youtube.con hitps:/iwww.youtube.comiwatch?v=itdza8kY0zY
Total "Parts” Needed B 7

Number of Ingredients 3 4 2 4 4
|Avg Price / Serving | $0.80 $0.99 $0.75 $1.00 $1.25 I

Tutorial Link https:/www youtube.comiwal hitps:/www. youtube comiwa https:/iwww youtube comiv hitps:/www youtube con https:/iwww youtube com/watch?v=itdza8ky0zY

After Currency Formatting
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Formulas

You can click a formula to add,

or you can start typing any formula with a “=" sign followed by the
formulas' name

= Spreadsheet Basics Tutorial michael@michaelgrubbs.com
File Edit View Insert Format Data Tools Add-ons Help Lastedit was yesterday at 6:39 PM \ Comments
& e~ o~ P $ % 0 00 123- Adal 10 B 7 5 A. ®-H =s-+.|+- ccBMY{Z
SUM
A B c D E F AVERAGE H
1 Scrambled Eggs French Toast Cereal Muffin Doughnut | COUNT
Ingredient List
MAX
2 Eggs 4 2 1
3 Bread 2 MIN
4 Milk 2
: More functions...
5  Cereal (or Flour) 2 3
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Using the SUM Formula

Spreadsheet Basics Tutorial

File Edit View Insert Formmat Data Tools Add-ons Help All changes saved in Drive

& e ~ T 0§ % .0 .00 123- Ardal 10 B 7 5 A. ®-H E-l-|+- co BT -Z
A B c D E F G

y Ingredient List Scrambled Eggs French Toast Cereal Muffin Doughnut L°T:§:e':;|.i::tp”

2 Eggs 4 2 1 1 0.33
3 Bread 2 0.1
4 Milk 2 0.5
5 | Cereal (or Flour) 2 3 3 0.2
&  Butter 1 1 2 2 0.25
7 Salt 1 0.05
8 Sugar 2 3 4 0.1

=]

Total "Parts" Needed

10 Number of Ingredients
11 Awg Price / Serving
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sing the Count Formula

Spreadsheet Basics Tutorial

File Edit View Insert Format Data Tools Add-ons Help All changes saved in Drive

& e A~ T s % .0 00 123- Ardal 10 B 7 5 A. ®.H -4+ coHMY - Z
A B B D E F G
1 Scrambled Eggs French Toast Cereal Muffin Doughnut Price per Unit
Ingredient List
2 Eggs 4 2 1 1 0.33
3  Bread 2 0.1
4 Milk 2 0.5
5  Cereal (or Flour) 2 3 3 0.2
6  Butter 1 1 2 2 0.25
7 Salt 1 0.05
8  Sugar 2 3 4 0.1
%  Total "Parts" Needed 6 7 4 9 10
10 Number of Ingredients
11 Avg Price { Serving
12 Tutorial Link hittps:/iwww.youtube.comiwal hitps:/www.youtube.com/wa hitps:/fwww.youtube.comiw https:/iwww.youtube.con https:/iwww.youtube.comiwatch?v=itdza8kY0zY
13
14
15 | |
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Using the Count Formula -

Spreadsheet Basics Tutorial michael@michaelgrubbs.com

File Edit View Insert Format Data Tools Add-ons Help  All changes saved in Drive Comments

& o~ P s % 0 .00 123-  Aral 10 B 7 5= A. &.H =-+-+ BlY - -z

=COUNT( )
A B @ D E F G
1 Scrambled Eggs French Toast Cereal Muffin Doughnut Price per Unit
Ingredient List
2  Eggs 4 2 1 1 0.33
3 Bread 2 01
4 Milk 2 0.5
5  Cereal (or Flour) 2 3 3 0.2
&  Butter 1 1 2 2 0.25
T Salt 1 0.05
8  Sugar 2 3 4 0.1
%  Total "Parts” Needed 6 7 4 9 10
10 Number of Ingredients 3 4| 2| 4 4
11 Avg Price / Serving
12 Tutorial Link https:/www.youtube. comiwal https:/hwww.youtube.comiwa https:/fwww.youtube.comfv https:/fwww.youtube.con hitps:/www.youtube.comiwatchPv=itdza8kY0zy
13
14
15
16
17
+ = Sheet1 Sheet2 Making Breakfast
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Using the Average Formula

Spreadsheet Basics Tutorial

File Edit View Insert Format Data Tools Add-ons Help  All changes saved in Drive

& e~ P s % .0 00123 Aral 10 B 7 5 A. ®-H -1 -+ coBHMY- =
A B @ D E F G H 1 J
1 Ingredient List Scrambled Eggs French Toast Cereal Muffin Doughnut Lowest Price per Highest Price per
Ingredient Ingredient
2  Eggs 4 2 1 1 0.33 0.5
3 Bread 2 0.1 0.2
4 Milk 2 0.5 0.75
5  Cereal (or Flour) 2 3 3 0.2 0.5
&  Butter 1 1 2 2 0.25 0.5
7 Salt 1 0.05 0.15
8  Sugar 2 3 4 0.1 0.2
2 Total "Parts" Needed 6 7 4 9 10
10 Number of Ingredients 3 4 2 4 4
11 Avg Price / Serving
12 Tutorial Link hitps:/fwww.youtube.comiwal https:/iwww.youtube.comiwa hitps:/iwww.youtube.comiv https:/fwww.youtube.con hitps:/iwww.youtube.comiwatch?v=itdza8kY0zY
13
14
15
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Using Simple Arithmetic Formulas

We need to calculate the total cost of the breakfast by
multiplying the average price of each ingredient by its unit
count in the recipe.

= Spreadsheet Basics Tutorial
File Edit WView Insert Format Data Tools Add-ons Help  All changes saved in Drive

& e~ T s % .0 .00 123-  Ardal 10 B 7 5 A. &-H =-1-|- BWY - =
| =$124B2+$13xB3+SLxai+8T5+85+5 6xc+sT7wa7+s15x88 e | yOU Click @ cell, it will show the underlying formula here
A B © D E F G
1 Ingredient List Scrambled Eggs French Toast Cereal Muffin Doughnut LOT:;:;?::*LDM
2  Eggs 4 2 1 1 0.33
3 Bread 2 0.1
4 Milk 2 0.5
5  Cereal (or Flour) 2 3 3 0.2
6  Butter 1 1 2 2 0.25
7 Salt 1 0.05
8  Sugar 2 3 4 0.1
%  Total "Parts" Needed B 7 4 9 10
10 Number of Ingredients 3 4 2 4 4
11 Avg Price / Serving
$2.14|
12 Tutorial Link hitps:www.youtube.comiwai https:/fiwww.youtube.comfwa hitps:/iwww.youtube.comf hitps:/fwww.youtube.con hitps:/www.youtube.comiwatch?v=itdza8ky0zY
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Share, Protect, and Move Data

FILE > SHARE

i= Spreadsheet Basics Tutorial michael@michagigrubbs.com =
File Edit View Insert Format Data Tools Add-ons Help Comments m

& e~ P s % .0 .00 123 Arial 10 B 7 5 A . 3B E -l |- coBEHY - Z
A 3 c D E F G H
Ingredient List Scrambled Eggs French Toast Cereal Muffin Doughnut Lowest Price per Highest Price per .
Ingredient Ingredient
2 Egos 4 2 1 1 0.33 05
3 Bread 2 01 0.2
4 Milk 2 0.5 0.75
3 Cereal (or Flour) 2 3 3 02 05
&  Butter 1 4 2 2 0.25 0.5
T Salt 1 0.05 0.15
&  Sugar 2 3 4 0.1 02
% Total "Parts” Needed 6 10 4 9 10
10 Mumber of Ingredients 3 4 2 4 4
11 Avg Price / Serving
g2.14 §2.93 §1.95 S2.67 §2.82

12 Tutorial Link https:/fwww. youtube.comiwa hitps:fwww. youtube.comfws https:ifwww.youtube.comiv hitps:fwww.youtube. con https:/fwww.youtube. comiwatch?v=itdzaBkY0zY
13
14
15
16
17
18
19
20
21
22

Sheet1 Sheet2 Making Breakfast

+
I
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Additional Options

When you open “advanced” sharing panel, you will see a
number of options.

Sharing settings Link copied to
clipboard by default

https://docs.google.com/a/michaelgrubbs.com/spreadsheets/d/1 TKyVrFelas3xasdjelx

Link to share (only accessible by collaborators) /

_th has access
o Private - Only you can access Change...
Who has access to
—_— Michael Grubbs (you) N
the spreadsheet 1 B b Is owner _
Change the spreadsheet
permissions from private to
- public or "only your
. organization"
# Canedit -

Make it so no-one can
mod|fy these Sharing \D-A'rc;rsc::inge Learn maore

. Prevent editors from changing access and adding new people
settings

Disable options to download, print, and copy for commenters and viewers
/ﬂ Change what they

can do to your

If you're sharing your spreadsheet spreadsheet

publicly and don't want people copying it
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Link Sharing

Link sharing

(A On - Public on the web

Anyana on the Intemet can find and accass. No sign-in required.

= On - Anyone with the link

An ‘y"D ne | n yD ur C D m pan ‘y" . Anyona who has the link can access. No sign-in required.
who can access the folder —* B On-Mchaclombbs
Anyane al MichaelGrubbs can find and access,
!
Wh ere lt S StDrEd can B On-Anyone at MichaslGrubbs with the link
aCCe S S Anyonea al MichaelGrubbs wha has the link can access

Off - Specific people

Shared with specific people.

MNaote: ltems with any link sharing option can still be published to the web. Learn more

“ Cancel Learn more about link sharing
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Sharing Spreadsheets with Devices and Apps

Helpful add-ons

The Google Docs mobile apps
Google Drive sync to your desktop
A Third-Party tool like Zapier

E 1 S.. Share new Google Sheets
- spreadsheets to Slack

zapier
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Post In Slack Channel

This is great for updating your team when you
create or update documents

.
Go g|e M - : Michael Grubbs testfeed 10 @ % -
mi
& Drive My Drive > Zapier « a H Eoaz CHANNELS
o zapier
.
&%  Shared with me S i DIRECT MESSAGES
4% Google Photos 3 7 sl
® Recent ﬁ a
- + Invite People
Y Starred B Googlesp ) Basics ... :
B Trash

28 MB of 30 GB used
#testfeed

This is the very beginning of the #testfeed channel, which you
created today. The purpose of this channel is: Send any and all
automated tests from integrations! (edit).

== Upgrade storage

his channe

Zapier monitors my Google Drive for new
Spreadsheets

Today

Sheets Bot

- Michael has created a new Spreadsheet named "Spreadsheet Basics
Tutorial” - Click here to edit:
hit,
ela

If a new spreadsheet is found, it posts the
custom message to Slack!

om/a/mich:; s/d/17KyVrF

s://docs.google.c
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Adding Slack Messages to Spreadsheet

1 5"‘ . Add Slack messages to a Google
— Sheets spreadsheet
: : ichaelgrubbs.com ~ . [ ]
Spreadsheet Basics Tutorial ] N zapier 10 @ % h
File Edit View Inset Format Data Tools Add-ons Help Al changes saved in Drive m
5 e P s % 0 00 12 Arial 10 B r 5 A & .0 More
A B c D E
Person Breakfast Timestamp -
Z Iil # zapier
3
4
s DIRECT MESSAGES
&
7
a8
2
0 + Invite People
T .
12
13
14
15
18
17 H
- #zapier
e This is the very beginning of the #zapier channel, which you created
20
= today.
22 & Set a purpose + Add a service integration £ Invite others to this channe
23
24
25
26 Today
7
® g michael
29
a0
n
+ = Breakfast Log Making Breakfast
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Downloading Your Data

Spreadsheet Basics Tutorial

File Edit WView Inset Format Data Tools Add-ons Help  All changes saved in Drive

Share... il 10 B I & A & . B E- 1 -3 co H ] ¥ Z
Mew -
c o E F G
QOpen... 0
Rename... Timestamp
z Make a copy...
3 ¢ @ Move to folder... 1449197844
4 r i Move to trash 1449197847
5
r Impart... 1449197850
[}
r , , o 1449197855
= See revision history #+Option+Shift+G
Spreadshest settings...
10 e g Microsoft Excel | .xlsx)
I Publish to the web... OpenDocument format (.ods)
12 . .
n Email collaborators... PDF document (.pdf)
14 Emall a6 adtachment... Comma-separated values (.csv, current sheet)
15 & Print wp Tab-separated values [.tsv, current sheet)
s Web page (.zip)
17
18

CSCI 2000U Scientific Data Analysis - Jarek Szlichta
30



Use Your Spreadsheet in Offline Mode

Google

Start a new spreadsheet

To-do list

Today
Spreadsheet Basics Tutorial 2

Spreadsheet Basics Tutorial

Previous 30 days

Google Sheets CRM Tutorial

Earlier
Untitled spreadsheet
Sheets Business Templates

Tips for Sheets

2015 Calendar Invoice

Owned by anyone -

me

me

me

me

me

me

Expense Report

Weekly time sheet Expense report

Last opened by me

10:29 PM

10:29 PM

MNov 17, 2015

1 2015

Aug 13, 2015

Jul 29, 2015
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Google Forms



Versatile Tool

Forms are among the internet’s most versatile
tools
Whether you need

a contact form or a checkout page,
a survey or a student directory,

a form is all you need to easily gather that
information

With Google Forms, it only takes a few
minutes to make one for free.
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Tour of Google Forms

Standalone app from early 2016

Google

Start a new form

_|_

Event Registration Event Feedback Order Form Job Application

Recent forms Owned by anyone ¥

Stuff and other stuff Event Registration Quiz Untitled Form

BB Opened 3:53 PM B Opened 3:52 PM B Opened 2:57 PM B Opened 2:41 PM
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Event Registration

QUESTIONS RESPONSES

Event registration

Event Timing: January 4th-6th, 2016
Event Address: 123 Your Street Your City, ST 12345
Contact us at (123) 456-7890 or no_reply@example.com

Name = Short answer 9
Tr
s
o
[—D [] Required ~ @@ —
Email * o
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Building Your First Google Form

= Testsheet
File Edit View Insert Format Data Tools Form Add-ons Help Lastedit was yesterday at 3:08 PM

= e s % 0_ .00 123 Create a form B 7 5 A . - H
Script editor...
A B E F G
1 Name Spelling... or: Pricing from: Centralized Da
2
3 Task Lists v Enable autocomplete
4 App: ASANZ Notification rules... rs $5/mo./user ¥
5 5] App: DAPUI ogress wit $25/mo. for 5 ug v
6 ] App:INSIGE | rotectsheet... s $12/mo./user |¥
i &

App: TOODLEDC Outline everythi « private tasks | $14.99/yr./user ¥
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Multiple Choices

What's your favorite notes app? (® Multiple choice
Tr
Evernote
s
OneNote n
I
Apple Notes -

Add option or ADD "OTHER"

Required :

]
|
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Linear Scale

How much do you like Zapier =+ Linear scale

1 to 5

I—D [ ] Required :
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When would you like to visit the White House?

&

G Date

l—D i Required

CSCI 2000U Scientific Data Analysis - Jarek Szlichta
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Google Forms Field Options

QUESTIONS RESPONSES

N I Wl Wl W WA I “w” 1 & § &1

Short answer

Paragraph

Untitled Question (® Multiple choice
Tr
Option 1 Checkboxes
Dropd
Add option or ADD "OTHER" ° ropdown B
[ ]
=+ Linear scale -

@ Multiple choice grid

G Date

Option 1 .
@ Time
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Build Quiz

Settings

GENERAL PRESENTATION QUIZZES

. Make this a quiz
Assign point values to questions and allow auto-grading.

Quiz options

Release Grade:

@ Immediately after each submission

O Later, after manual review
Sending grades to respondents requires email addresses. To collect emails,
restrict to Zapier users in the "General" tab.

Respondent can see:

Missed questions 0

Correct answers 0

Point values @)

CANCEL SAVE
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Build Quiz - Answers

Choose correct answers:

What's the square root of 4 4 - points

16

Jl ADD ANSWER FEEDBACK

2 EDIT QUESTION
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Form Responses

QUESTIONS RESPONSES

(2 responses)

Jan 1,2016 1:01 AM

Mar 3, 2016 3:03 AM

What's your favorite name for random things? (7 responses)

@® bob

@ stuff
Thing 1

Qi

@ Option 1
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Get Notified When Your Form is Filled Out

|
B s

send email via Gmail for new Google
Forms submissions

£

Share Google Forms responses in a
Slack channel

Send Twilio SMS messages with new

®

Google Forms responses

zapier
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How to Create a Custom
Business Analytics Dashboard



Data

means little on its own.

Open a spreadsheet packed with numbers,
and it is difficult to tell what is improving and
where you should focus your efforts

Wou

dash
num

d not it be better if you could make a
ooard that automatically turns your

oers into clear, actionable insights?



With a spreadsheet and some data

integration, you can build the custom
dashboard.
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Build a Reporting Dashboard

Install the Google Analytics plugin

Add-ons

Check out the store for many more

Google Sheets

e EXEn
v oAk [484) google-analytics-add-ons :

S o o Pos % oo 00 Arial 0 B I & A % - H =-1-5 coH
Tx
A & c D E F
1 {
2 Last Run On 02014 223659
3 WView [Profile) Name Goagle Siore
4 Tatal Results Found 82
5 Tatal Results Returned 5 Top Five Browsers
& Contains Sampled Data Na
7 Cheae
Totals For All Results
a ga:visits Frefax
10 41958
Imterrat Explonar

-

#ndraid Drcesr

13 gacbrowser gavisits

14 Crrome 19314

15 Firefox BHE1

16 Intemet Explorer 5168 o sn00 yoc0n 15000
1w Aredroid Browser JGeE

1& Safan 3650

19

0
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Create New Report

Click Add-ons
Select Google Analytics Plugin
Create new report

Untitled spreadsheet 2]

File Edit View Inset Fommat Data Tools Add-ons Help Allchanges savedinD

= - oy = - ~ o alvtics — = gl v
o~ $ % .0_ .00 123 Arial Google Analytics  » e iE————a 1 -] co @l ¥V - 2

Got-add-ons Run reports

Schedule reports
Manage add-ons " *

Help
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Selecting Site

You should select the site, which you need to
create a traffic report about

. e
= Blogging-Dashboard

File Edit View Insert Format Data Tools Add-ons Help  All changes saved in Drive Comments | |

- alia | T—‘ $ % .0_ .00 123 Arial 10 B TS 9. H 1 More Create a new report x

1) Name Your Report

i
T

) B [+ o] E F G H | J

Name
1
2
3
4 2) Select Account Information
g Account
]

BoumanBlog =
7
8 Property
g http:fwww.boumanblog.com =
10
11 View (Profile)
12 www.boumanblog.com =
13
Lo 3) Choose Metrics and Dimensions
15
1% Metrics
17
18 Metrics Reference
1e Dimensions
20
21

Dimensions Reference

2
-]
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Choosing metrics

Choose metrics and click Create Report

Blogging-Dashboard |

File Edit View Insert Fomat Data Tools Add-ons Help All changes saved in Drive Comments

oo ~ T s % .o .00 123 Arial 10 B 7 5 A @ - H 1 — More Create a new report X

Related Products

A B8 c D ¢ F G e I J
Related Product Quantity
) Ecommerce
3 Revenue per User
User
S Number of Sessions per User
= Ecommerce
; Refunds
: " . . x Users | x Sessions | x Bounce Rate
Click to get a list of metrics to

s x Avg. Session Duration
: choose from for your report.
1 - x Organic Searches
13 ‘
14 Dimensions
16
17
2 Run report when you have desired metrics. Cancel
19
% ve ’
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Report Configuration

The extension will then add a new “Report Configuration” sheet to your
spreadsheet, and it'll automatically populate with your site analytics data.
This is where we'll get the data for your dashboard.

Blogging-Dashboard

File Edit View Insert Format Data Tools Add-ons Help All changes saved in Drive

= =~ F
Configuration Options

A
Configuration Options
Report Name
Type
View (Profile) ID / ids
Start Date
End Date
Last N Days

Metrics

%  Dimensions

Sort

Filters
Segment
Sampling Level
Start Index
Max Results

Soreadsheet URL

$ % .0_ .00 123 Arial
- =

core
ga: 11758069

7

ga.users
ga:sessions
ga:bounceRate
ga:avgSessionDuration
ga:organicSearches

+ = IRepcr‘t Configuration

l Sheet1

12

m
|
1+

B|(Z & A. ®-H

C [}
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Default Number of Days

By default, the spreadsheet will show data
from the past seven days

but you can change that by changing the number
in column B7 beside Last N Days,

or removing it and adding start and end dates.
Typically data from the past 30 days—and
comparing to the previous 30 day periods—
gives the best feel for month-over-month
growth.



Comparing with Previous Period

=] Blogging-Dashboard i

n Drive Comments
= o ~ T s % 0 00123~ Adal . 10 B T SA @ . H - T Sl b BHBhYy - = -
A 8 c D E F G
Previous Month Blog

Report Name Current Blog Metrics Metrics
3 Type core core

View (Profile) ID / ids ga:11 ga: 11758069
5  Start Date 2/1/2018 1/1/2016
6  End Date 2/29/2016

Last N Days 7 7

Metrics

Dimensions

10 Sort
1 Filters
Segment

Copy the first report and paste it into
a second column for your second report.

13 Sampling Level

14 Start Index

5  Max Results

Report Configuration Dates Sheet1

——
I
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Run Reports

Now that you have the dates for your three reports,
it's time to run the report.

In the top menu in Google Sheets, select Add-ons -> Google Analytics -
> Run Report.

= Blogging-Dashboard 5|
File Edit Wiew Insert Format Data Tools Add-ons Help All changes saved in Drive

—
= y g - § is GO A ey r | = (o= . .
= i $ % .0 .00 123 Arial Google Analytics - O — 1 = B ] 7 3

Run reports

Get add-ons

B o
Schedule reports

'
. h‘..‘a":ac_:]!a- add-ons
Help

Previous Moni
Report Name Current Blog Metrics Metrics
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Three new Sheets

The Google Analytics extension will automatically
add three new sheets

= Blogging-Dashboard esse.bouman@gmail.com ~
File Edit View Insert Format Data Tools Add-ons Help  All changes saved in Drive Comments
& o o~ T § % o .00 123~ Aral 12 B 7 5A. & -BH-BH- =-5-1=- coEHMY- =
Current Month Blog Metrics
A B c D E F G H
1
2 Last Run On 2(24/2016 21:00:57
3 View (Profile) Name www.boumanblog.com
4 Total Results Found 1
5 Total Results Returned 1
6 Contains Sampled Data No
7
8
9
L Totals For All Results
11 ga:users ga:sessions ga:bounceRate ga:avgSessionDuration ga:organicSearches
12 204 216 0.912037037 31.16203704 152
13
B Results Breakdown
15 ga:users ga:sessions ga:bounceRate ga:avgSessionDuration ga:organicSearches
16 204 216 0.912037037 31.16203704 152
17 . .
18 After running the report, three new Sheets will be created
0 with the traffic data from your chosen dates.
20 ’
+ = Report Configuration Current Month Blog Metrics Prior Month Blog Metrics Next Prior Month Blog Metrics Dates Sheet1
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ashboard

Rename Sheetl to Dashboard and populate it with
data

% BIOgging-Dashboard jesse. bouman@gmail.com -
All changes saved in Drive Commants |
& e ~ T s % .0 00123+ Aral 10 B Z s A. &-H =- Lol BlY- X
A B B D E F G H | J K L

2

3  Blogging Metrics

4

5  Time Frame Current Month _ Next Prior Month

&  Users 204 376 295

7 Time Frame Current Month _ Next Prior Month

8 | Sessions 216 390

8  Time Frame Current Month _ Next Prior Month

10 Organic Searches 152|=

11 Time Frame Current Month _ Next Prior Month

12 Bounce Rate 0.912037037

13

14

15

16

= In your dashboard, add an equal sign and then find

@ the corresponding metric in your metrics spreadsheet.

18

20

21

22

+ = ‘port Configuration Current Month Blog Metrics Prior Month Blog Metfrics Next Prior Month Blog Metrics Dates Dashboard {4 »
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With Colors

So the values stand out

jesse.bouman@gmail.com -

=i Blogging-Dashboard

File Edit View Insert Format Data Tools Add-ons Help  All changes saved in Drive Comments |
& e o~ T s % .0 00 123 Arial 10 B 7 5 A .- H E-1-+- coBMY- X
A B C D E F G H J K L

2

3 Blogging Metrics

4

5  Time Frame Current Month _ Next Prior Month

8  Users 204 376 295

7 Time Frame Current Month _ Next Prior Month

8  Sessions 216 390 315

2  Time Frame Current Month _ Next Prior Month

10 Organic Searches 152 189 169

11 Time Frame Current Month _ Next Prior Month

12 Bounce Rate 0.912037037 0.9153846154 0.8984126984

13

14

15

18

17

18

19

20

21

22

+ = ‘port Configuration Current Month Blog Metrics Prior Month Blog Metrics Next Prior Month Blog Metrics Dates Dashboard { )
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That's still a bit hard to read, so we'll turn

these metrics into charts that will let you see
what growth

Just highlight the cells that you want to
represent visually

perhaps the 3 months of data for Users, first

then click Insert -> Charts in the top menu



3
4
5
6
7
8
9

Nt e by || | s |
= O ©® ® N ® ;s W N s

)
3

Creating Chart

Blogging-Dashboard

File Edit View

=5 e P

Time Frame

A

Time Frame
Users

Time Frame
Sessions

Time Frame
Organic Searches
Time Frame
Bounce Rate

port Configuration

Insert Format Data

Row above
Row below
2 Rows above

2 Rows below

Column left
Column right
4 Columns left

4 Columns right

New sheet

Comment #

Note

2 Function

[la] Chart...
[as] Image...

G2 Link...

B Form...

EY Drawing...

Current Month Blog Metrics

Tools Add-ons Help Allch

¢
@
0
T

10 -|'B Z 5 A
—

.VNext Prior Month .
176 295
. Next Prior Month
190 315
. Next Prior Month
89 169
. Next Prior Month
54 0.8984126984

8K

Prior Month Blog Metrics Next Prior Month Blog Metrics Dates

co H Y

Dashboard
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Chart Options

Google Sheets will show you the chart options

= Blogging-Dashboard
File Edit View

- ale s Chart Editor
Time Frame "
A Recommendations = Chart types  Customization [Select your desired chart format. ] Help L

Dashboard!AS:DE

ra

3 Users vs. Time Frame
4 Users Users vs. Time Frame
400
5 | Time Frame ] - — Users
6§  Users
7 Time Frame | o . 300
8  Sessions —
2 Time Frame )
Users vs. Time Frame Users vs. Time Frame 1
10 Organic Searches | % 200
11 Time Frame /\
12 Bounce Rate
13 | I 100
14 |
15 Users vs. Time Frame Histogram of Users
0
18 I Current Month Prior Month Next Prior Month
17 |
" — Time Frame
19
20
Cancel
21
= |
+ = ‘port Configuration Current Month Blog Metrics Prior Month Blog Metrics Next Prior Month Blog Metrics Dates Dashboard  » Sum: 875 = Explor
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Adjusting Size and Location

And if you selected the wrong data, click the pencil
icon to edit the data, labels, or chart style

= Blogging-Dashboard

File Edit View Insert Format Data Tools Add-ons Help  All changes saved in Drive Commaents |

& e o~ T 0§ % 0 .00 123~ Ardal 10 B|Zf § A. S-H-Bd~- E-1- |- coBMY-Z

Time Frame

A B © D E F G H 1 J K L

2 _
3
4
5 |Time Frame Current Month [PriofMop#h | Next Prior Month
6 U | @
7T Til .
s s Users vs. Time Frame V4

=
s Ti 400 — Users
CHE \
1 i

Tii 300
12  Bg
13 " After you insert your chart, you can adjust the size
L g 200 and location of it in your dashboard.
15 =
16
17 100
18
19

0

20 Current Month Prior Month Next Prior Month
21
an Time Frame

+ = ‘port Configuration Current Month Blog Metrics Prior Month Blog Metrics Next Prior Month Blog Metrics Dates Dashboard F] » Sum: 875 & u Explor
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ther Metrics

Repeating the process for other metrics

= Blogging-Dashboard

File Edit View Insert Format Data Tools Add-ons Help All changes saved in Drive Comments
& o T § % g 00123+ Adal 10 B 7 5 A & - H =-1-+- coBWYvY-Z
- = — —
A B @ D E F G H J K L M N o
1
’ _
Users vs. Time Frame Sessions vs. Time Frame
3
4 400 —— Users 400 Sessions
5  Time Frame Current Month _ Next Prior Month
&  Users 204 376 295 300 300
7 Time Frame Current Month _ Next Prior Month ”
8 Sessions 216 390 315 4 s
) - g 200 g 200
8 Time Frame Current Month _ Next Prior Month =1 k]
10 Organic Searches 152 189 169
11 Time Frame Current Month _ Next Prior Month 100 100
12 Bounce Rate 91.20% 91.54% 89.84%
1 0 0
14 Current Month Prior Month Mext Prior Month Current Month Prior Month Next Prior Month
i Time Frame Time Frame
16
17 Arrange the charts as you see fit. Then
e remove the gridlines and your dashboard o icS h Time F
19 is comp ete. rganic Searches vs. [Ime Frame Bounce Rate vs. Time Frame
20
200 —— Organic W Gounce
21 Search Rate
22 Current Month
150
23 3
£ 5
24 g %
3 5
> ? e s rer rmoﬁth_
] ®
g E
- :
°  m
* Next Prior Mo...
29
30 0
31 Current Month Prior Month Next Prior Month 89.60% 90.10% 90.60% 91.10% 91.60%
22 Time Frame Bounce Rate
33
34
+ = Report Configuration Current Month Blog Metrics Prior Month Blog Metrics Next Prior Month Blog Metrics Dates Dashboard
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Conditional Formatting

Format -> Conditional Formatting

=] Blogging-Dashboard Jesse.bouman@gmail.com =
File Edit View Insert Format Data Tools Add-ons Help  All changes saved in Drive Comments |
e B Bt B S B eC B0 oo x5 B I AT 10 B 7 S A AN KA T =-1l- -+ coBWM[Y-Z Conditional format rules x
Single color Color scale
A B @ D E F G H J
4 auu — Users
Apply to range
5  Time Frame Current Month _ Next Prior Month
6  Users 204 376 205 300 A15
7 Time Frame Current Month _ Next Prior Month
8  Sessions 216 390 315 4 200 F Lcels i
: ormat cells if..
8  Time Frame Current Month _ Next Prior Month 3
10 Organic Searches 152 189 169 Cell is not empty s
11 Time Frame Current Month _ Next Prior Month 100
12 Bounce Rate 91.20% 91.54% 89.84% Formatting style
12 0 Default -
14 Traffic Change Current Month > Prior Month Current Month Prior Month Mext Prior Month
15 Time Frame B 7 5 A L4
16
17 Traffic Change Prior Month > Next Prior Month R
18 | | Cancel
19 Organic Searches vs. Time Frame
20 )
200 = Orpganic Add another rule
21 Searc...
22 150
23 2
£ ;
24 £ E
+ = Report Configuration Current Month Blog Metrics Prior Month Blog Metrics Next Prior Month Blog Metrics Dates Dashboard 4 »
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Traffic Change

=SUM(C5-D6)

e.bouman@gr

All changes saved in Drive Comments
= o~ T s % 0 .00 123- 1 - B Z 5§ A. &-H- el |- coEHMY -2
=Sum(
A 8 c D £ P G t | J K L
: _
Users vs. Time Frame Sessions vs. Time Fra
3
p 400 Ui 400
5  Time Frame Current Month —Noxt Prior Month
6 Users 204 3761 2951 300 300
7 Time Frame Current Moi — Next Prior Month &
8 Sessions 216 390 315 4 8 e
g 200 Z 200
9  Time Frame th _ Next Prior Month S 2
10 Organic Searches 152 189 169
Time Frame Currefy Month _ Next Prior Month 100 100
12 Bounce Rate 91.20% 91.54% 89.84%
13 0 - - ’
14 Traffic Change Current Mgiith > Prior Month Current Month Prior Month Next Prior Month Current Month Prior A
= | S rime F
16
7 |®1* B Change Prior Month > Next Prior Month
18] |=Sum(
10l Organic Searches vs. Time Frame Bounce Rate vs. Time
20 200 Nrnanie
+ = Report Configuration Current Month Blog Metrics Prior Month Blog Metrics Next Prior Month Blog Metrics Dates Dashboard 4 »
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=

Prior Month and Next Prior Month

Populating cell A18

Blogging-Dashboard

File Edit View Insert Format Data Tools Add-ons
e o Sl S % 0l .00l 123 | Arlal
A B C

Help All changes saved in Drive
10 B 7 5 A. ®-H E-1-+- cocHMY-Z
D E F G H J
Users vs. Time Frame
400

— Users

295 300

200

Users

Time Frame Current Month _ Next Prior Month
Users 204 3786

Time Frame Current Month _ Next Prior Month
Sessions 2186 380 315
Time Frame Current Month _ Next Prior Month
Organic Searches 1562 189 169

Time Frame

Bounce Rate 91.20% 91.54%

Traffic Change Current Month > Prior Month

Traffic Change Prior Month > Next Prier Month
81/

Report Configuration Current Month Blog Metrics

4
1

Current Month _ Next Prior Month 100

89.84%

Current Month Prior Month Mext Prior Month

Time Frame

Organic Searches vs. Time Frame
200

— Cirmanic

Prior Month Blog Metrics Next Prior Month Blog Metrics Dates Dashboard 4«
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Comments

Sessions vs. Time Fra
400

300
200

100

0
Current Month Prior h

Time F

Bounce Rate vs. Time
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Adding Additional Metrics

Go back to Report Configuration tab
Add-ons -> Google Analytics -> Create Report again

@ BlOgging-DaShboard jesse.bouman@gmail.com -
File Edit View Insert Format Data Tools Add-ons Help  All changes saved in Drive Comments |
e v S e o o0 $923 - (VA rial 10 B 7 5 A @ - H =-1-2- More Create a new report x

New Users source

A B c o E
2) Select Account Information
L Configuration Options
Account
s Current Month Blog Next Prior Month Blog . - N
Report Name Metrics Prior Month Blog Metrics  Metrics R v
3 Type core core core Property
4 View (Profile) ID / ids ga: 11758069 ga: 11758069 ga: 11758069 http: flwww.boumanblog.com i
5 Start Date 2/1/2018 1/1/2016 12/1/2015
View (Profile
8  End Date 2/22/2016 1/31/2016 12/30/2015 Tew ( )
www.boumanbleg.com S
T LastN Days
ga:users ga:users ga:users
z ga:sessions ga:sessions ga:sessions 3) Choose Metrics and Dimensions
ga:bounceRate ga:bounceRate ga:bounceRate
Metrics ga:organicSearches ga:organicSearches ga:organicSearches Metrics
¢  Dimensions For this report, we're going to add bewlisers
1 Sort Dimensions to our Metrics. Metrics Reference

11 Filters Dimensions
12 Segment

13 Sampling Level
14 Start Index

Dimensions Reference

15 Max Results | Cancel
18 Spreadsheet URL

+ Report Configuration Current Month Blog Metrics Prior Month Blog Metrics Next Prior Month Blog Metrics Dates Dashboard 4 »
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Dimensions gives us an extra layer of information for
our metrics
In the “Metrics” field, add New Users. Then below

that in Dimensions, add the Source field

= Blogging-Dashboard

File Edit View Insert Format Data Tools Add-ons

s oo o T s % o0 0013 Arial

A B

LI Configuration Options

Current Month Blog

Report Name Metrics

3 Type core

4 Wiew (Profile) ID/ ids ga: 11758069

5  Start Date 2/1/2018

&  EndDate 2/22/2016

7 LastN Days
gaiusers
ga:sessions

ga:bounceRate
ga:organicSearches

Metrics
¢  Dimensions
10 Sort
Filters
12 Segment
13 Sampling Level
14 Start Index
15 Max Results

18 Spreadsheet URL

+ = Report Configuration Current Month Blog Metrics

Help

All changes sa

B 7 5 A

Prior Month Blog Metrics
core

ga: 11758069

1/1/2016

1/31/2016

ga:users
ga:sessions
ga:bounceRate
ga:organicSearches

Prior Month Blog Metrics

CSCI 2000U Scientific Data Analysis - Jarek Szlichta

ved in Drive

Next Prior Month Elog
Metrics

core
ga:11758069
12/1/2015
12/30/2015

gausers
ga:sessions
ga:bounceRate

|1—

=l

More

jesse.boumar

Comments

Create a new report

Mew Users Source

2) Select Account Information

Account

BoumanBlog

Property

http:/iwww.boumanblog.com

View (Profile)

‘www.boumanbleg.com

L

3) Choose Metrics and Dimensions

gaorganicSearches Metrics
New Users
[Add your desired dimensions for your mc1rics‘] Metrics Referance
\ Dimensions
Source | |

Next Prior Month Blog Metrics

Dates

Dashboarc

1

Dimensions Refarence

Cancel
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ew Users Source

Click Create Report, set the dates for three month
period as before.
Go back to Add-Ons and run the report again.

=] Blogging-Dashboard jesse.bouman@gmall.com ~
File Edit View Insert Format Data Tools Add-ons Help All changes saved in Drive Comments

& e ~ T 0§ % .0 .00 123- Anal 12 B 7 s A. %.H-Bd- =E-+-+- coBM Y- X
New Users Source
A B c D E F G H I 4 K

2 Last Run On 31712016 11:03:55
3 View (Profile) Name www.boumanblog.com
4 Total Results Found a5
5  Total Results Returned a5
& Contains Sampled Data Mo
7
8
]
ga:newlsers
12 867
13
2
15 ga:source ga:newlsers
18 (direct) 138 In the Results Breakdown, you’ll see the
17 |aol 2 de==mmmme | results for the Dimensions you specified
18 ask 1 in your report.
18 bing 32

20 bouman.is

s PP S T

+ = Report Configuration Current Month Blog Metrics Prior Month Blog Metrics Next Prior Month Blog Metrics 4 »
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oving Datafrom A toC

Click Create Report, set the dates for three month
period as before.
Go back to Add-Ons and run the report again.

Blogging-Dashboard jesse.bouman@gmail.com ~
File Edit View Insert Format Data Tools Add-ons Help  All changes saved in Drive Comments E
& e A~ T 0§ % 0 00 123- Al 10 B 7 5A. ®-H-F- =E-1-1-- coBHMY- X
ga:source
A B c D E F G H | J K
8
]
10
n ga:newUsers
12 867
18
14 s B do
s ga:newUsers |ga:source
16 138 | (direct)
17 2| aol
18 1|ask
18 32|bing
20 1|bouman.is

2 e— ic-=-betteru|  [Move the data from column A to column C. )

22 1| build-audience.fi
23 0 |disq.us
24 2 |duckduckgo.com|
25 1|facebook.com
28 440 |google
27 1|google.co.kr
28 1|google.com
+ = Report Configuration Mew Users Source Current Month Blog Metrics Prior Month Blog Metrics Next Prior Month Blog Metrics {« Count: 36 Explore
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Sorting Data

Data -> Sort Range, column B, Z -> A

:=] Blogging-Dashboard [ 2sse.bouman@gmail.cc

Comm

File Edit View Insert Format Data Tools Add-ons Help All ¢

- e i % .0 .00 Sort sheet by column B, A — = . — co ] ¥
I t st y col BA—-Z B 7 5 A & 1
=) - — L
ganewllsers Sort sheet by column B, Z — A
) ] E F G H | J K
Sort range by column B, A — Z

8 ¥
a | Sort range by column B, Z - »Al

(LI Totals For All Results

Sort range

5 MNamed ranges

2 Protected sheets and ranges.

B eete Bevicices e
e

17 YT Filter
18 Filter views.. >
Pivot table

Validation

3 atter-bu
22 1 build-audience.fi
23 0 disq.us

24 2 duckduckgo.com
25 1 facebook.com
26

27

28

+ = Report Configuration New Users Source Current Month Blog Metrics Prior Month Blog Metrics MNext Prior Month Blog Metrics 4 "

Sum: 867 = u
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Top Ten Sources

S

12
13
14
15
16
17
18
19
20
21
22
23
24
25
2
27
28
29
a0
a1
a2

File

Pie Chart

Blogging-Dashboard

Edit

ga:newlsers

View | Insert |Format Data Tools Add-ons Help
e ol S S 0l Lol a230 | Arfal 10
A B
867

ga:newUsers
440

138

101

32

3

27

27

1

-

B I

[+

-
-

s

All changes saved in Drive

$- M0

++

E

Il
n

Select the 10

ten sources, go to Insert, and select chart.

ga:source
google

(direct)
traffic2cash.xyz
bing
top1-seo-sarvice
traffic-cash.xyz
yahoo
share-buttons.xy
images.google.fr|

images.google.d

4
9
8
7
4
4
4
2
2
2

Report Configuration New Users Source

kitchennightmar:
scripted.com
t.co
topseoservices.c
aol
build-a-better-bu
duckduckgo.com

Current Month Blog Metrics

jesse.bouman@gmail.com ~

ga:newlsers

® google

@ (direct)
traffic2cash.xyz

@ bing

@ topl-seo-
service.com

@ traffic-cash.xyz

@ yahoo

@ share-buttons. xyz

@ images.google.fr

@ images.google.de

Prior Month Blog Metrics
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Next Prior Month Blog Metrics {4«

Comments
J K
L |
-l ®
rd
u
Sum: 827 & Explore
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omething’s off Here

the chart isn’t in our main reporting dashboard. To
rectify this, just select the pie chart and copy it—just
press Ctrl + Cor CMD + C.

— Ie
= Blogging-Dashboard

File Edit View Insert Format Data Tools Add-ons Help  All changes saved in Drive Comments E
& o ~ T s % .0 00 123+ Anal 10 B 7 5 A. . .H E-1-|+- coEHmMY-Z
A B C D E F G H | J K L

14 Traffic Change Current Month > Prior Month Current Month Prior Month Next Prior Month Current Month Pric
B T2 4574 Time Frame Tim
18
17 Traffic Change Prior Month > Next Prior Month (Pastc your chart where you'd like it to appear in your dashboard. ]
18 81 27.46% | '
19 Organic Searches vs. Time Frame Bounce Rate vs. Tin
2 200 —— Crganic
21 ga:newUsers Searc...
22 Current Month

® google L, 150
23 @ (direct) 2 ®
24 traffic2eash... E E

E .

= oo 03 o t Frioronh _
28 @ top1-sec-se... E E
27 @ traffic-cash.... g

@ yahoo 50
& share-butio. .. Next Prior Mo...
29
30 12V "]
- Current Month Prior Month Next Prior Month 89.60% 90.10% &
a2 Time Frame Bov
33
34
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ook Less Like a Spreadsheet

uncheck the gridlines option under the View menu

=] Blogging-Dashboard [} 550 bouman@gmail.com
File Edit View Insert Format Data Tools Add-cns Help All changes saved in Drive Commaents
[ e | Freeze > . 10 . B £ 5 A £ 1 — co & :Iu: hd z
_—
| Gridlines I
D E F G H J K L
Protected ranges
1
2 - v Formula bar .
All formulas - Users vs. Time Frame Sessions vs. Time F

8 ormulal C

F 400 = Users ]

5 Time Frame - Next Prier Month

6  Users ) _ — 376 295 300 300

7 Time Frame ’ o R - Next Prior Month =

8 Sessions Full screen 490 315 g 200 ’9 200

o Time Frame Current Month [BRISEMBRERN Next Prior Month 3 8

10 Organic Searches 152 189 169

11 Time Frame Current Month _ Next Prior Month 100 100

12 Bounce Rate 91.20% 91.54% 89.84%

13

14 Traffic Change Current Month > Prior Month In View, uncheck Gridlines. Hior Month Current Manth Prit

A &= | The gridiines between individual

: . cells will disappear.
17 Traffic Change Prior Month > Next Prior Month
18 81 27.46%
19 Organic Searches vs. Time Frame Bounce Rate vs. Tin
ol o 200 — = Organic
+ = Irce Current Month Blog Metrics Prior Month Blog Matrics Maxt Prior Month Blog Metrics Dates Dashboard Mailchimp P »
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Beyond Google Analytics

How to Pull Data from Any App into Your Dashboard

Save new Typeform entries to a
Google Sheets spreadsheet

Save new Eventbrite attendees to a

Google Sheets spreadsheet

Save Gmail emails matching certain
traits to a Google Spreadsheet

A

ave Twitter mentions to a Google

LA

heets spreadsheet

heets

]
%]

Add new rows on Googl

new PayPal sales

Add Data to a Spreadsheet from a

er P P P P B

Webhook

zapier
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Reading List

Recommended
Tutorial (Guide to Online Spreadsheets)

https://zapier.com/learn/google-sheets/google-sheets-tutorial/
Chapter 1,2 and 6 (Rest of the chapters Optional)

Optional

Comprehensive Tutorial (Compact)

https://www.shorttutorials.com/google-docs-
spreadsheet/index.html|

Advanced Features

https://www.geckoboard.com/blog/part-1-6-google-sheets-
functions-you-probably-dont-know-but-should/
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